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1 Introduction

In the previous sections we showed how LISREL models may be specified and estimated by drawing the
appropriate path diagram from which the SIMPLIS or LISREL syntax is created. The examples used were based on
data from a single sample. The path diagram can, however, also be used to create syntax for models based on data
from several samples simultaneously, according to a multiple-group LISREL model with some or all parameters
constrained to be equal over groups.

Consider a set of G mutually exclusive groups of individuals. It is assumed that a number of variables have been
measured on a number of individuals from each of these populations. This approach is particularly useful in
comparing a number of treatment and control groups regardless of whether individuals have been assigned to the
groups randomly or not.

Any LISREL model may be specified and fitted for each group of data. However, LISREL assumes by default that
the models are identical over groups, i.e., all relationships and all parameters are the same in each group. Thus,
only differences between groups need to be specified.

2 Testing Equality of Factor Structures

Table 1 below gives sample covariance matrices for two samples ( N, =865, N, =900, respectively) of candidates

who took the Scholastic Aptitude Test in January 1971. The four measures are, in order, VERBAL40, a 40-item
verbal aptitude section, VERBALS50, a separately timed 50-item verbal aptitude section, MATH35, a 35-item math
aptitude section, and MATH25, a separately timed 25-item math aptitude section.

Table 1: Covariance Matrices for SAT Verbal and Math Sections

Covariance Matrix for Group 1

Tests VERBAL40 VERBALS0 MATH35 MATH25
VERBAL40 63.382

VERBALS0 70.984 110.237

MATH35 41.710 52.747 60.584

MATH25 30.218 37.489 36.392 32.295



Covariance Matrix for Group 2

VERBAL40 VERBALS0 MATH35 MATH25

Tests

VERBAL40 67.898

VERBALS50 72.301 107.330

MATH35 40.549 55.347 63.203

MATH25 28.976 38.896 39.261 35.403

The data are used here to illustrate how one can test equality of factor loadings and factor correlations in a
confirmatory factor analysis model, while allowing the error variances to be different.

We regard VERBAL40 and VERBALS50 as indicators of a latent variable Vverbal and MATH35 and MATH25 as
indicators of a latent variable Math. The model we consider is shown in the figure below.
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—=VERBALS0
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= MATH25

There are three sets of parameters in the model:

o the four factor loadings corresponding to the paths from Verbal and Math to the observed variables,
o the correlation between Verbal and Math, and
o the four error variances of the observed variables.

We begin by constructing a data file pdex10.cov containing the two covariance matrices. In free format, each
covariance matrix can be written on one line.

|- pdex10.cov E=N[EoR X"
63.382 70.984 110237 41.710 52.747 60.584 30.218 37.489 36.392 32.295
67.898 72.301 107.330 40.549 55347 63.203 28.976 38.896 39.261 35.403

We assume that all parameters are the same in both groups. The syntax file pdex10a.spl (see the Simplis Examples
folder) is:

Group 1: Testing Equality Of Factor Structures Model A: Factor Loadings, Factor Correlation, Error Variances Invariant
Observed Variables: VERBAL40 VERBAL50 MATH35 MATH25

Covariance Matrix from File PDEX10.COV

Sample Size = 865

Latent Variables: Verbal Math

Relationships: VERBAL40 VERBALS0 = Verbal

MATH35 MATH25 = Math

Group 2: Testing Equality Of Factor Structures



Covariance Matrix from File PDEX10.COV

Sample Size =900

Set the error variances of VERBAL40-MATH25 free
End of Problem

In the syntax above, the data in the covariance matrices and the sample sizes are different. The names of the
variables, observed as well as latent, are the same, and the model is the same.

Select the New option from the File menu and select Path Diagram in the New dialog box. Click OK when done.
Enter the name pdex10.pth. When done, click Save.

It is possible to control specific SIMPLIS default features such as Maximum Number of Iterations or Method of
Estimation. From the Output menu, select SIMPLIS Outputs.
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The SIMPLIS Outputs dialog box will appear. Customize this dialog box according to your preferences, for
example, by changing the Number of Decimals in the Output option to 4 and by making sure that the Invoke path
diagram option is selected. Click OK when done.
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Before drawing the path diagram, select Toolbars from the View menu and ensure that the items shown below are
selected. These are: Toolbar, Status Bar, Typebar, Variables, Drawing Bar. Optionally, check the Grid Lines option.
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Select the Title and Comments option from the Setup menu to obtain the Titles and Comments dialog box.
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The first item on the Setup dialog box is the Title for the problem. Provision is also made for any additional
Comments that the user may wish to enter. After typing in the title and (optionally) the comments, click Next to
go to the Group Names dialog box.
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Next we enter a description for each group. Group labels can be inserted by clicking on the first string field,
entering the label for the first group and then using the down arrow on the computer keyboard to create the next
group’s string field. When done, click Next to go to the Labels dialog box.
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The default number of variables shown on the Labels dialog box is 3, these being CONST, VAR 1 and VAR 2. Move
the mouse pointer to the Observed Variables box and click in the string field of CONST. Rename this variable to
VERBAL40. Press the "down arrow" on the keyboard to move to the second observed variable string field and enter
the label VERBALS50. Proceed in a similar way to enter the labels MATH35, MATH 25 and the labels Verbal and Math
for the latent variables. Click Next when done to go to the Data dialog box.
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From the Data dialog box, select Covariances from the Statistics from: drop-down list box and also Covariances
from the Matrix to be analyzed drop-down list box. Enter 865 in the Number of Observations string field. For File
type select External ASCII Data.
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Click the Browse button to select the path and name of the file that contains the values of the covariance matrices
of the 2 groups. For the present example, the file is pdex10.cov, which was created earlier in this section. Click
Open when done.

From the Data dialog box, select the second group from the Groups: drop-down list box. Proceed as outlined
above to enter the number of observations (900), file type and matrix to be analyzed.

3 Drawing the Path Diagram

We now proceed with the actual drawing of the path diagram. Start by clicking on the VERBAL40 label under the
Observed variables portion of the variables window. Hold the mouse button down and drag the label to the draw
area. A rectangular-shaped object will appear on this part of the screen when the mouse button is released as
shown below. Repeat this procedure until all observed variables are dragged to the drawing area as shown in the
next image.

Note also that:

e The observed variables are assumed to be X (or independent) variables unless appropriate check boxes
under the Y-column are checked.

e The latent variables are assumed to be Ksi (or independent) variables unless appropriate check boxes under
the Eta-column are checked.
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Proceed by dragging the latent variables, Verbal and Math, to the draw area of the path window. Note that the latent

variables are represented by elliptically shaped objects.

Finally, arrows can be drawn pointing from the latent variables to the observed variables. To accomplish this,
click on the single-headed arrow of the Draw toolbar (seen on the right of the picture given below). As an
alternative, use the Draw menu on the main menu bar. The related drawing tool options may be selected from this

menu.

Once the single-headed arrow (or One-way Path option) has been selected, move the mouse pointer to within one
of the elliptically shaped objects. With the left mouse button held down, "drag" the arrow to within a rectangular-
shaped object. When the colors of both objects change (see diagram below) release the mouse button.
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Proceed in a similar way to graphically display the relationships between the observed and latent variables:
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Select Build SIMPLIS Syntax from the Setup menu. SIMPLIS syntax will be built from the path diagram and is
stored in a system file named pdex10.spj shown below.

Group 1: Testing Equality Of Factor Structures Model A: Factor Loadings, Factor ~
SYSTEM FILE from file 'C:\LISREL Examples\SIMPLIS examples\pdex10a.DSF'

Sample Size = 865

Latent Variables Verbal Math

Relationships

VERBAL40 = Verbal

VERBALS0 = Verbal

MATH35 = Math

MATH25 = Math

Path Diagram

Group 2: Testing Equality Of Factor Structures

SYSTEM FILE from file 'C:\LISREL Examples\SIMPLIS examples\pdex10a.DSF'

Sample Size = 900

Latent Variables Verbal Math|

Relationships

Set the Error Variance of VERBAL40 Free

Set the Error Variance of VERBALS0 Free

Set the Error Variance of MATH35 Free

Set the Error Variance of MATHZ25 Free v

Observed  Latent |
VERBALAD | Verbal

-]
YERBALSD | Math Fram | Set Path | a"|jJ J
=)

MATH3S

MATH25 To | Setvaiance | 7| 8] 3]

Free | SetCovariance | 4| ﬂ ﬂ j
Fix | SetEvorVaiance | 1| ﬂ ﬂ ﬂ .
Equal | SetErrar Eovariance| 0 |J ﬂ

Click the Run LISREL icon button to fit the multi-sample model to the data. The parameter estimates and ?
goodness-of-fit index are shown on the path diagram displayed below:
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Chi-Square=33.78, df=11. P-value=0.0003%, RMSEA=0.048

The values shown on the path diagram are the parameter estimates. This is the default selection. It is, however,
also possible to view the t-values, modification indices or expected changes by selecting the view menu on the
main menu bar. Alternatively, use the drop-down list by clicking in the Estimates: pane as shown below. To view
t-values, select the T-values option. The figure below shows how this is done and also indicates the t-values on
the path diagram.
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To view the corresponding t-values for the second group, select group 2 on the menu bar. The resultant changes
in the path diagram are shown in the next image.
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In the example above, the error variances, factor loadings and factor covariance are constrained to be equal
(invariant) across the two groups. To test for invariance of factor loadings and covariance only, the error variances
can be freed as follows. Make sure that the path diagram is displayed, and then select Group 2 from the Groups:
text box. Right-click in the error variance of VERBAL40 and click the Free option. Repeat this procedure for the
remaining three error variances, and then select the Setup, Build SIMPLIS Syntax option.
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The actions described above result in a new SIMPLIS project file that contains the syntax required to free the error
variances across groups.

When done, click the Run LISREL icon. The output file reveals two solutions, one for each group. The value of
22 is reported only after the second group.

In a multi-sample analysis, the 7 is a measure of fit of all models in all groups, and, in general, this »* cannot

be decomposed into a »? for each group separately. For our example, y? is 10.87 with 7 degrees of freedom (p
= 0.14), so that the model does fit the data.
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